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What is Infrared Interactive Whiteboard?  

Infrared Interactive Whiteboard is a comparatively new member of the various IWBs widely 

installed and applied. It adopts infrared matrix sensing technology, enabling the touchableness of 

any operation on the board together with computer and projector.  

The user can write and draw directly on the whiteboard and conduct any operation of the 

computer by hand or pen. Furthermore, you can save, print, display and manage all the 

information in your computer and from the internet with the IWB directly, which has been a very 

modern solution for education and is in tune with the new generation’s digital nature.  

Technical Requirements 
 

The minimum and recommended hardware and software required to use KALBOARD Complete 

software is: 

 Minimum  Recommended 

Operating System Standalone computers using 

Windows® 

XP SP3 (32 Bit), Windows 

Vista™ (32 or 

64 Bit) or Windows 7 (32 or 

64 Bit) 

Standalone computers using 

Windows 7 (32 or 64 Bit) 

Processor 300MHz x 86 1GHz x86 

Memory 128MB 256MB 

Storage (to install) 400MB 500MB 

(in use) 500MB 1GB 

Graphics card 64MB 256MB 

Screen 1024x768 1024x768 or above 

 

The following prerequisites are required: 

 

Microsoft® .Net Framework 3.5 SP1 

Microsoft® .Net Framework 4 Client Profile 

Flash Player v10 for non-Internet Explorer® browsers 

Windows® Media Player 11 or above 

Ogg Video / Audio Codec 

CD-ROM Drive 

USB Port  
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How to install software? 

 

Connect the computer and the whiteboard by USB cable, (the following installation example is 

the installation under WINDOWS XP, a slight difference maybe in other operation systems). 

 

Insert the Software CD into your CD-ROM, then click the Software Setup icon. Choose the 

language you prefer and click “Next” to install the software 
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Follow the instructions to complete the software’s installation, and then click “Finish”. 

 

If the driver installed properly, the USB indicator of the whiteboard will light in red. 

Just click the “KALBOARD Complete” icon on the desktop, which is our 

application software, to start working   
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Connecting the Board 

 

When you connect the IWB to the computer through USB cable, the computer will detect the 

IWB automatically. 

To establish communication between computer and the IWB: 

1. Make sure the IWB and computer are connected by a USB cable. 

2. Start the driver, double click the icon.  on the desktop to connect.  

3. To check the status of the IWB, check the driver icon    in the taskbar: 

 

  

  If driver blinking the board Not connected 

 

 

  Connected    

Board Calibration 

To calibrate the IWB before using, right-click the icon  in the taskbar, and choose “Calibrate”. 

Then you would see the screen like below: 
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Click the center point of     the cross for 2or 3 seconds until the color of the cross 

changes to blue and raise your hand to the second point until you finish the 4 points to complete 

the calibration. 

 Attention: 

1. The calibration is necessary only at the first time the IWB is connected. 

2. Re-calibration is required only if the IWB, computer or projector has been adjusted, 

changed or relocated. 
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Physical Board Toolbar  
 

 

Mouse  

 Clicking this button updates the mouse pointer to show you are in select mode. 

You can now select objects and perform actions on them.  

 

New Page  

Add new page. 

 

Previous Page 

To return to previous page.  

 

Next Page 

To progress to the next page. 

 

List Page  

Show or hide Page list. 

 

Open  

Choose and open picture, drag along the screen to locate the picture. 

 

Black Pen  

 

Red Pen 

 

Blue Pen 

 

Green Pen 

 

Eraser 

 

Laser Pen 

 

Spotlight  

Allows you to focus on specific areas on the screen 

 

Keyboard  

On-Screen keyboard 

 

Calibrate  

To calibrate board 

 

User Define  

To define a shortcut for any frequently used program  
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Software Menus and  Toolbars   

File  

 

 

  

New 

Click “New” in the “File” tab or the icon   to create a new file. The system will ask  

you whether to save the current document or discard it. After choosing “Yes” or “No” a 

new file will be created.    

 

 

New page  

Add new page. 

 
 

Open 

If you want to input file from your computer when you are using software, just click 

“Open” in the “File” tab or the icon  and then choose the file you want to input. 

You can input file in the formats (INT, pdf , MS(Word, Excel, Power point) files of 

2007.  
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 Recent files  

This tab displays the most recently opened documents. Select one to open it.  

 
 

Save 

This option saves the current document. If it is the first time you have saved the 

document, the window that displays will allow you to choose location to save it to. 

 
 

Save as 

This option save a copy of the current document. A 

window will open allowing you to choose a 

location to save the document to.  

 

 
Export 

Click “Export” in the “File” tab or the icon  You can save file in formats such as, 

Image, PPT, PDf, HTML. 

 

 Email 

You can set an account in outlook first and email, current writing content as an  
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attachment (.INT,.PDf, .PPT) 

 Print 

You can print any image or content displayed on the board at any time with a printer that 

is connected to the computer. Simply click print.  
 

 Print Part 

Print rectangle of the slide, which can be determined by the user. 

 Print Preview 

Preview and Make changes to page before printing. 

 Exit 

Close software. 

Edit  

 

 

 

Undo  

To undo the last action preformed on the page. 

 

Redo  

To redo the last undo action. 

 

Cut  

To cut an object, you first need to have it selected and then click this button. 

 

 

Copy 

To copy an object, you first need to have it selected and then click this button. 

 

 

Paste 

To paste an object, you need to have it either previously copied or cut. 

 

 

Clone  

 (copy + paste) 

To clone selected object.   
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Delete  

To delete selected object.   

 

 

Select All 

Select all objects on current page. 

  

 

Home  

To move the current page.  

 

 

Reset 

This option returns the current page to the last saved state . 

 

  

 

Zoom in 

To zoom in page, select zoom in then click on the page. 

 

 

Zoom out 

To zoom out page, select zoom out  then click on the page. 
 

When a few pictures are piled up together, each picture takes up a different layer. select an 

picture, and click Top, Bottom, up one level, or Next level from the “Edit” or from the toolbar, 

then click any point on the page, the layer of picture or geometry shapes will change. 

 

 

 

 

Select the rectangle, and click “Bottom”. 

The new layer will become: 

Top - triangle 

Between - circle 

Bottom - rectangle 

Current layer is as following: 

Top - rectangle. 

Between- triangle 

Bottom- circle 
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Horizontal mirror  

You can use the Horizontal mirror feature to create a mirror image of the currently selected 

object. First select object and then click Edit - Horizontal mirror. Please note, this feature flips 

only the selected object.  

 

 

 

 

 

 

 

 

Vertical mirror  

You can use the Vertical mirror feature to create a mirror image of the currently selected object. 

First select object and then click Edit - Vertical mirror. Please note, this feature flips only the 

selected object. 

 

 

Lock  

This allows you to lock the position of an object on a page to prevent editing by 

mistake. Clicking the lock object button will lock the selected object in the position it is 

located on the page. An object cannot be moved when it is locked. 

 

unlocked  

The object is unlocked and can be moved around the page once more.  

 

 

Select Locked  

Select locked object  

 

Page  

- New page: add new page. 

- Delete page: delete current page. 

- Clear page: clear all the content of 

the current page. 

- Clone page: clone current page. 

- Previous page: return to previous 

page  
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- Next page: progress to the next 

page.  

- Zoom In 

- Zoom Out  

View 

 

 Background Color  

To change background color and picture   

 Toolbar  

Show or hide toolbar (File toolbar, Playback toolbar, Tool toolbar, Edit toolbar). 

In the tab “View”, we can select what toolbar to be shown or hidden by ticking on or 

ticking off. 

By dragging the head of the main toolbar, we can move it to any position.  If you close 

it, you can re-open it from View-Main Tool. 

 

 Language 

 To choose language click View – Language, then choose the language desired and 

restart the software.   
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 Main Tool  

To view or hide main toolbar.  

 

 
 

 Show Manage Widget  

Show or hide Manage widget. 

 

 Skin 

change the interface style.  

 Page Layout 

Single Page: View single page.  

Double Page: View any two pages side by side  

 



16 
 

  

Display Mode 

 
Full Screen: opens KALBOARD  in full screen so you don’t see other application menus. 

Window Mode: the default mode for editing. 

Frameless Mode: open software without frame  

 

Screen Postil 

Click the icon or click “Tool menu—  “ 

Screen Marker”. It allows you to place an 

annotation layer over the top of an 

application. One of the many important 

features of this software is to annotate on 

videos  Microsoft Office files such as 

WORD, EXCEL, PPT., then you can click 

“office embed” to insert your / annotations  

handwriting into those files.   

 System Setting:  

 Allows you to choose the default interface settings  

 Coustom Hotkey 

 Reguler Save  

 Default voice and  text to speech speed and volume  
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Draw  

 

 

 

Select  

To select an object, to be able to edit it indifferent ways according to its type. 

 

 

Pen and pen setting 

 

Pen  
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You can draw and write freehand with Hard Pen. 

 

 To set ( Pen width, line style, pen color) 

 

 
 

 

Multi Write  

It allows 4 users to write on the Board in parallel. 

 

Spread Pen  

 

You can use this tool as a brush for drawing. 

 
Soft Pen   

You can draw and write freehand 

 

Fluorescent Pen 

  
It enables you to highlight any text or object on the page in different colors. 

 

 

Texture Pen  

 

 

 

 

 

 

You can use the texture pen to draw and write on the page using a selected texture or 

image you choose instead of plain colors. 

 

 

Smart Pen 

The smart pen can identify simply hand drawn graphics (line , arc, traingle, rectangle, 

ellipse,…etc) 
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Handwritten Graphics Identified Graphics 

 
 

  

  

 
 

 
 

 

Laser Pen 

 

You can use this tool to point to a specific contect, text or picture on the page. 

 

Fill Color  

The fill tool allows you to fill shapes with different colors. 

  

 

Line 

 

You can draw the line by clicking and dragging on the page. The start of the line is 

created at the first click and the end of the line is where the mouse pointer is released.  

 

 

Top 

Sends the object to the top most layer.  

 

Bottom 

Sends the object to the bottommost layer. 

 

Up 

Sends the object one step forward. 

 

Down  

Sends the object one step backward. 

 

Text 

To insert text, Click “Text” icon and Drag on the whiteboard page,you will see the 

following input area and tool bar
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 There are two ways to insert text into the page: 

 

1- On-screen keyboard:  

Tap on the letters to form your words and sentences. 

 

 

2- Handwriting recognition 

In the handwriting area, start writing with your finger in the box  your 

writing will be converted to standard text. When you finish click insert. 

 

 
 

Text to speech  

The text to speech functionality enables text on the page to be read by one of the voices 

installed in your operating system.  

 

 Video  

To insert a video or movie, Click “video” icon, choose and open the video file,   
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Eraser 

You have two type of erasers: 

 

Eraser Object  

Move the eraser to draw a circle to select and delete the circle content. 

 
  Eraser Point  

Touch the icon, drag it through any point that you want to 

erase including any part of a picture. 

 

Plane Geometry  

When you select one of the shapes, you can draw the shape 

by clicking and dragging on the page. You can always 

resize the shape drawn at any time. 
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Solid Geometry 

When you select one of the shapes, You can draw the shape by clicking and dragging on 

the page. You can always resize the shape drawn at any time. 

 

 

Pie chart  

 

 
Histogram 

 

Tools   

 

 

 
Full Screen: opens KALBOARD  in full screen so you don’t see other application menus. 
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Screen Postil 

Click the icon or click “Tool menu—  “ Screen 

Marker”. It allows you to place an annotation 

layer over the top of an application. One of the 

many important features of this software is to 

annotate on videos  Microsoft Office files such 

as WORD, EXCEL, PPT., then you can click 

“office embed” to insert your / annotations  

handwriting into those files.   

 

 

 
Screen Grab 

you can find “Screen Grab” under “Tools”, or click the icon. 

ScreenGrab(capture) is like a camera, you can use it to capture an image of the current 

screen.It gives you three option for capturing: 

Screen: Captures the whole screen. 

Rect: Draw an rectangle around the area you want to 

capture. 

Custom: Free draw the area you want to capture. 

In additon to inserting the image to the page, you can 

export , save or do both for later use. After the capture 

is taken , drag on the page, and then the captured 

picture will show.  

  

 
Record 

you can use this tool to record what happens on your screen, which enable the audience to 

review what was said or written during the meeting. 

Click Tools - Screen Record or the icon. 
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Click       to start recording , and you can choose the location to save it. 

 
 

 

 you will see this button     which informs you that the recording starts. Click on 

the button when you finish. 

 
Spotlight 

Spotlight allows you to focus on specific areas of the screen, it will draw the attention of 

your audience  to focus on particular contents on the whiteboard. 

Click the icon or click “Tool menu—Spotlight” you can move the spotlight by clicking 

and dragging on the darkened area.   

 
Hold on the dark screen for two seconds or click 

the menu on the right bottom of the whiteboard 

for pop-up menu. Set the attributes through the 
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pop-up menu and sub-menus.  

 

Curtain 

The curtain will cover the whole page with its contents, and your audience will be eager 

to know what’s behind it while you drag it and reveal the page from the four corner. 

Click the icon or click “tool menu— Curtain”, drag on the whiteboard page,then the cover 

will appear with four arrows as illustrated below： 

 

 

 

Prominent Show 

Click the icon or click “Tool menu—  “Prominent Show”, to cover the present screen first 

Then use your finger / mouse to circle the area that you want to highlight. The highlighted 

area will be displayed as illustrated below:  

 

Blank Screen  

It enables you to hide the contents of a page then 

reveal by moving blank screen.  

 

 

Screen Arrow 

On many occasions, teachers will walk down from the platform to interact with students. 

The screen arrow can be used to identify the main points or the on-going contents. In this 

way, every student can easily follow up with the class, and teachers can avoid influence of 

any exterior interference on the teaching quality and schedule. 
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Select Screen Arrow through “Tools-Screen arrow”, or click icon 

you will see a red arrow in the middle of the screen.  Drag the 

head part of the arrow to change its direction or position. Click 

the right button of the mouse or hold your finger on the arrow for 

two seconds to activate its setting menu to change its attributes or 

to exit. 

 Insert Table 

Click “Tool menu—  “ Insert Table”. 

You can draw the table by clicking and dragging on the page.  

 
 

Special Tools 

Calculator, Magnifier, Clock, Screen Keyboard, Dice 

 
Calculator 

Select Calculator through” Tools-Special Tool-Calculator” or click icon, then the 

calculator will appear, just use your finger  to click the calculator on the  screen. You can 

use the Calculator to perform simple calculations such as addition, subtraction, 

multiplication, and division. Calculator also offers the advanced capabilities of a 

programming, scientific, and statistical 

calculator.  
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Magnifier 

Use  the Magnifier function to enlarge the parts of the 

screen easily, just select “Tools-Special Tools-

Magnifier” or click  icon  to directly activate magnifier 

window, the parts centered around the cursor can be 

enlarged in adjustable proportion. 

 
Clock 

Select  Clock through” Tools-Special Tools- Clock ” or click icon. 

The Clock shows the time of the system, can be used to count down and count time. The 

clock window can be moved to any location ,and its perporteries can be adjusted 

through  the settings. 

 

 

 

 

            Timer 

 

 

       

 

 

       

 

                                                

Digital clock 

 
Keyboard 

This option opens the on-screen keyboard that comes with your operating system.  

 

 

Dice  

The Dice, ideal for use during game play. Click on the dice and the dice will be shaken. 

 

Subject tools 

 
 Math Tools 

Ruler 

This is a 13 centimeters / 6 inch ruler that can be laid over items on the page in order to 

measure them. 
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 Set Square   

 Protractor 

This is a 180° protractor that can be laid over items on the page to measure their angles. 

 
 Compasses 
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Caliper  

The caliper widget is used for measuring distance/lengths of objects. 

 

 

 

 

 

 Physics Tools 

 

 
 Chemistry Tools 

 

 
 Help 

Should  you have any questions on how to use the software, please click Help on the 

Toolbar for the help file. 

 Manage Widget 

Page view 

Right click on the page you want to delete, add, clone, clear, lock or unlock. 
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Play Back  

The whole operating process on the board can be redisplayed by the following buttons: 

 Play and stop  

When you click “Play”, you will see the following controlling bar 

 Speed up/ down : Adjust the speed of playing to faster or slower. 
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Resource 

 

The software offers a picture resource, in which there are 

hundreds of images categorized to different subjects.  

To Import images from the resource bank, click Resource at 

Manage Widget, select a picture, drag and drop on to the 

software page directly. 

 

 

 

 

How to show, hide and move the toolbar 

In the “View” tab, you can select which toolbar to be shown or hidden by ticking it on or off.   

 

We can move the toolbar to any position, by dragging the dotted line on the left 

hand side of the toolbar.  

Multi-Touch 
 

You can use Multi-Touch function to resize any object on the page. Using both fingers drag the 

corners of the object to set the size you want. 

 

 


